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CHAPTER 1: Introduction 

 

Barbecana’s Schedule Inspector is an add-in to Microsoft Project® (2007 and above). Once installed, it is 

accessed through the Microsoft Project menu system.  

 

Schedule Inspector helps improve the quality of schedules by checking for the use of scheduling features 

and techniques that many think should be used sparingly or not at all. Schedule Inspector is highly 

customizable to handle the different criteria imposed by various industries and organizations. You need 

perform only those tests you think are appropriate for your situation, and most of these tests can be 

customized. 

 

There is, however, a standard widely accepted in the defense industry, namely the “Integrated Master 

Schedule Assessment Guide” issued by the Defense Contract Management Agency (DCMA). Schedule 

Inspector specifically applies all 14 metrics in the DCMA guide, in addition to a number of additional 

tests (e.g. for out-of-sequence progress) mentioned in the introduction to that document.   

 

Schedule Inspector is intended for those wishing to comply with the DCMA standard and those who just 

want to produce more reliable schedules. 
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CHAPTER 2: Getting Started 

 

In this chapter we will explain how to install, activate, and register Schedule Inspector. We will then 

discuss how to start using it. 

 

Installation 

 

When downloading Schedule Inspector from the Barbecana website, choose to Save it rather than run it. 

Then double click on the downloaded setup program and follow the instructions. 

 

Activation 

 

Schedule Inspector is protected by a licensing system; however, you will receive a free 30-day trial after 

your first installation. The first time you enter Project, you will be given the opportunity to activate 

Schedule Inspector on a screen that resembles the following: 

 

 Figure 2.1 
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Activation is free but requires Internet access. (If you are in a secure environment without Internet 

access, you will get a slightly different screen enabling you to activate the software by email using a 

different computer.  If you are in a very secure environment where media cannot leave the area, there is 

an alternative activation and registration procedure.  Contact Barbecana for details.)  To activate your 

free trial, click on the Activate button. Schedule Inspector is now activated.   

 

Note: 

  

1. If you click on Close & Exit, Project will close down. (This is a feature of the third-party 

licensing software and is outside the control of Schedule Inspector.) When you reenter 

Project, you will not see the Software Activation dialog box again. The Schedule 

Inspector menu items will appear but will not be activated. Later, when you are ready to 

use Schedule Inspector, click on any of the Schedule Inspector menu options to request 

another opportunity to activate Schedule Inspector. (Schedule Inspector shows the 

activation screen only on start-up in order to avoid the possibility of you losing data if it 

causes Project to close down. After the first time it does so only when you have 

requested it as described here.) 

2. If you have downloaded and installed Full Monte as well as Schedule Inspector since the 

last time you launched Project, you will get the opportunity to activate only one of the 

two products.  To activate the other one, exit Project and re-launch it after waiting 20 or 

30 seconds. 

 

Registration 

 

Registration gives you permanent access to Schedule Inspector after you have purchased a license. Both 

the purchase and registration are done via the same dialog box, which looks like this: 
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Figure 2.2 

 

The dialog box appears periodically and with increasing frequency when your trial period is about to 

expire, but never more than once a day. (Again, if you do not have Internet access, the screen is slightly 

different and you can register by email.) You can also access the software registration dialog box via the 

menu, which brings up the dialog shown in figure 2.3. We recommend purchasing Schedule Inspector a 

few days before the trial period elapses to ensure uninterrupted use of the software.   
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Figure 2.3 

 

Note:  

 

1. After the trial period has expired, if you have not yet registered the software it will be 

partially disabled. Specifically it will not work on projects with more than 100 tasks or which 

include external subprojects.  This is intended for teaching purposes.  You can convert to a 

full license at any time by selecting Register Schedule Inspector from the menu as described 

above. 

2. As with activation, if you need to register Full Monte as well as Schedule Inspector, you will 

need to launch Project twice with a 20 to 30 second delay between the two.  

 

When you see the Software Registration window shown in figure 2.2, you have two options: 

 

1. To purchase the software, click on the Purchase button. You may use a credit card or your PayPal 

account. When completed, you will receive a license key by email. 
 

2. To register the software, copy the license key into the designated space in the Software 

Registration window shown in figure 2.2. Then click on the Register button. 

 

If you press the Continue Trial button, you will be returned to Project or to the Schedule Inspector 

function you requested. (If your trial period has expired, the Continue Trial button will not appear.) 

Closing the dialog box without registration will shut down Project. Re-entering Project, you will not see 

the registration dialog box again until you request it through the menu, as described above. 
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Using Schedule Inspector 

 

To try Schedule Inspector, first open a project in Project.   In Project 2010 and later, go to the Add-ins 

ribbon which should look similar to the one in figure 2.4.   Click on the Inspect Schedule Icon.  (In Project 

2007 there are no ribbons but you should see a Schedule Inspector menu.   Select Inspect Schedule from 

this menu. ) 

 

Figure 2.4  

 

You should then see the Schedule Inspector screen looking something like that shown in figure 2.5. 



 

8 
 

Figure 2.5 

 

Click the boxes next to the tests that you would like to run. Then click on Run Tests and select Run Now.  (If 

the Run Automatically option is checked you will not need to do this; the tests will be re-run whenever 

you make a change.)  Schedule Inspector will perform those tests and produce a result that is similar to 

the dialog box in figure 2.6. 

 

Note:   

 

1. Schedule Inspector remembers all your options, including the Run Automatically option.   If 

this is switched on, when you reopen Schedule Inspector it will run the selected tests. 

2.  You can interrupt processing by pressing the Escape key or by selecting Cancel from the Run 

Tests menu.  If you do this when the Run Automatically option is on, that option will be 

switched off. 
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Figure 2.6 

 

The results are color-coded: 

 

• Red – the project failed a test. 
 

• Yellow – the project passed the test, but some tasks were not compliant. The number of 

noncompliant tasks did not exceed the allowable percentage, or “Goal.” Setting values for Goal is 

discussed in Chapter 3, The Schedule Inspector Grid. 
 

• Green – there were no tasks out of compliance with the test. 
 

• White – the test was not requested or there were no tasks subject to the test. 

 

NOTE: in a few cases, the color-coding of results is reversed because the goal is for a minimum 

percentage of tasks to comply, rather than a maximum. In these cases, green indicates that 100% 

complied and yellow indicates that compliance was less than 100% but greater than the goal.  

 

It is possible to sort on some of the columns by clicking on the column heading.  In the case of the 

results column, sorting is done by color in order of severity: white, green, yellow, red.  To sort the most 

serious problems to the top, click on the column heading twice. 
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CHAPTER 3: The Schedule Inspector Grid 

 

There are seven columns in the grid presented by Schedule Inspector: 

 

Condition lists the tests that Schedule Inspector performs. Clicking on a cell in this column toggles the 

checkbox in the next column. 

 

Select contains check-boxes indicating whether you want to perform each particular test. If you 

consecutively check or uncheck two boxes in this column, Schedule Inspector will ask if you want to 

check or uncheck them all, allowing you to perform this function quickly. 

 

Note: There is an option under the Options menu to hide unselected rows and this option is 

cancelled when you choose to deselect all rows in this way.  (You must of course uncheck this 

option before you can select a test which is currently deselected.)   

 

Threshold (where appropriate) enables you to enter values used by the test. For example, one test 

counts the number of tasks with more than the threshold number of predecessors.    

 

Note: The thresholds for some tests are durations.  You cannot enter elapsed durations here, but 

the threshold will be interpreted as elapsed for any task whose duration is specified in elapsed 

units. 

 

Exclusions allow you to exclude certain types of tasks from the test. Each of these types is represented 

by a single character, as follows: 

 

• C – completed tasks 
 

• L – level-of-effort tasks (designated as defined in the configuration dialog) 
 

• M – milestone tasks (designated as defined in the configuration dialog) 
 

• N – tasks with no dependencies 
 

• P – planning package tasks (designated as defined in the configuration dialog) 
 

• S – summary tasks 

 

Note:  A few tests do not allow certain exclusions (see Appendix A) , in which case you will be unable 

to enter them.  Other tests have required exclusion; if you delete such an exclusion it will be 

reinstated. 

 

Goal indicates the minimum or maximum value allowed for tasks or relationships failing the test.  A “Z” 

will indicate that the goal is zero.  Otherwise the goal should comprise a < or > sign followed by a 

numeric value and an optional % sign.  (The = sign can be used in place of < or > but only if the numeric 
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value is 0, 1, or 100%)   The goal is interpreted as a percentage for all tests except the baseline execution 

index and the critical path length test.   

 

Note: To edit this field, it is generally necessary to delete its current content before typing in the 

new value. 

 

Result lists the results of the test, color-coded as described in the previous chapter.   Clicking on this 

column has the same effect as clicking on the button in the final column. 

 

The final, unlabeled, column contains buttons giving access to more information.  In most cases, if a test 

has been run and the result is yellow or red, the button will be marked Detail and will invoke a dialog 

containing a list of the specific tasks which failed the test.  (In other cases, for example if the test has not 

been run, the button will be marked Help and will access general help about the test.)   

 

Figure 3.1 shows an example of the Test Detail dialog.  There are options to highlight the listed tasks in 

the current Project view, or to filter the view to just those tasks.   (These will be disabled if you have not 

designated one of the custom flag fields for the purpose.  This can be done using the dropdown list on 

the dialog.  This can also be used to reserve different flags for different tests.)   

 

 
Figure 3.1 

 

Depending upon the test, there may also be options to fix all the problems globally, or to click on 

individual tasks for more information or to fix the problem. 

 

Note:  The Fix All button will never make any changes before describing specifically what it plans 

to change, and giving you the chance to abort the process.  An example is shown in figure 3.2. 
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Figure 3.2 

 

If instead you want to fix the problem on individual tasks, click on the row displaying that task on the 

dialog illustrated in figure 3.1.  This invokes a tabbed dialog similar to that shown in figure 3.3.  In this 

case you can fix the problem either by removing the milestone flag or by removing the resource 

assignments. 

 

Note:  using the five tabs you may be able to fix problems other than the one which led you to 

the dialog, and that the options enabled will depend upon all tests that this task failed. 
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Figure 3.3  
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CHAPTER 4: The Options Menu and Configuration Dialog 

 

The Options menu presents the following options: 

 

 Configure invokes the configuration dialog, which will be discussed in detail below. 

 Reset to System Default resets all configuration options, including exclusions, thresholds, goals, 

sort order, etc. to values we think most people will want. 

 Reset for DCMA resets all configuration options, including exclusions, thresholds, goals, sort 

order, etc. to values preferred by the DCMA. 

 Hide Unselected Rows can be checked and unchecked and controls whether unselected tests 

are shown. 

 Show DCMA Metric # can be checked and unchecked and controls whether the DCMA metric 

number is displayed as part of the description of the test. 

 Cancel Sort reverts the sort order to the default (which itself depends upon whether the last 

reset was for DCMA or not). 

 

Note: all settings, including those on the configuration dialog to be discussed below, are 

remembered from one run to the next.  This is normally done on a per-project basis, while for new 

projects it uses the most recent settings. 

 

The configuration dialog is illustrated in figure 4.1. 
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Figure 4.1 

 

This dialog allows you to specify: 

 

 Whether to exclude tasks without baseline data from most of the tests.  (It does not apply to the 

Baseline Execution Index; see Chapter 5.)  This is a DCMA requirement. 

 Which of the available baselines to use for the above and for all other purposes. 

 How Planning package tasks are defined.  This is either by one of the custom flag fields or by a 

particular string (the default is “PP”) in one of the custom text fields. 

 How the earliest date for a planning package is determined (see below). 

 How Level of Effort tasks are defined.  This is either by one of the custom flag fields or by a 

particular string (the default is “LOE”) in one of the custom text fields.  (In the latter case, it can 

be the same field as used for the planning package code.) 

 How Milestones are defined, which can use the Milestone flag or can be based on duration or 

on baseline duration.  (The number of days specified will be interpreted as elapsed days for any 

task with a duration specified in elapsed days.)  

 The Flag field to use for highlighting and filtering.  (As noted earlier, this can be modified for 

individual tests.) 
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 The task which indicates the end of discrete work.  (By default this is the logical end of the 

project, but for the purposes of DCMA metric #12 it can be defined as an earlier milestone.) 

 

In a rolling-wave scenario, work in the more distant future may be planned at a summary level, using 

tasks designated as planning packages.  These should not be scheduled earlier than a minimum date 

which will move through time as the project progresses.  The dialog allows the user to specify this as one 

of: 

 

 A specified period after the status date. 

 A specified period after the current system date.  

 A specific date, which the user would have to change manually as time progresses. 

 

In the first two cases above, this date can be further modified to align with a fiscal calendar, in which 

case the definition of the fiscal calendar can be specified as one of the following: 

 

 Calendar months. 

 4-week periods. 

 A 4/4/5-week pattern. 

 

In the case of the last two options, the start-date of the fiscal calendar sequence can also be specified. 
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CHAPTER 5: The Schedule Inspector Tests 

 

The various available tests are described in the Condition column and are presented here in alphabetical 

order.   

 

Most of the tests are applied only to those tasks which are not excluded as described in Chapter 3. 

 

Some tests take longer than others.  In particular, any of the three marked with asterisks (*) typically 

takes longer than all the other tests combined.  Doing all three at once takes hardly any longer than 

doing any one of them, so if you need them it is worth doing them all at the same time.  This is of little 

concern for smaller networks. 

 

Note: You can interrupt processing by pressing the Escape key or selecting Cancel from the Run 

menu.  If you do so when the Run Automatically option is on, that option will be switched off. 

 

Baseline duration exceeds threshold (DCMA metric #8): It is good practice to break work down into 

small pieces, especially if earned value cost control is employed. This test counts the number of tasks 

whose duration exceeds a user-specified limit. 

 

Baseline execution index (DCMA metric #14): This compares the number of tasks that have been 

completed with the number that should have been completed according to the baseline.  It expresses 

the results as the ratio: 

 

Number of completed tasks / Number of tasks with baseline finish dates on or before status date 

 

The ratio does not consider the identities of the tasks completed compared to those that should have 

been completed, but the detail dialog lists all those that should have been completed but are not.  It is 

therefore possible to have some tasks listed even if the ratio is 1.0 or even more than 1.0. 

 

Note: In calculating the denominator, any task without a baseline finish date is treated as if this date 

were before the status date. Since there should not be any such tasks, this test enforces the rule by 

creating an incentive to create a valid baseline for every task. 
 

Critical path length index (DCMA metric #13):  This is a measure of any negative total float on the 

critical path and is defined as: 

 

(Critical path length + Total float) / Critical path length 

 

where Total Float is the minimum total float among the tasks on the critical path. A value of 1 or more 

would indicate no negative total float. 
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 Critical path test (DCMA metric #12; adding threshold does not delay designated finish task): 
This test is designed to ensure that all tasks are tied into the project completion. It counts the number of 

tasks that have more than a user-specified amount of total slack when constraints are ignored. 
 

Duplicate Task Names: Task names should be descriptive of the work they represent and many project 

managers like them to be unique.   This also prevents confusion when selecting predecessors on the task 

dialog in Project. 

 

*Finish-to-start relationships (DCMA metric #4): Relationships other than finish-to-start should be used 

only in special circumstances, so it is desirable that the vast majority of relationships are finish-to-start. 

Unlike most of the tests, this one requires that the percentage of relationships that are of this type is at 

least equal to the goal, 90% by default.  

 

Note: Any task exclusions apply to the successor task only. 
 

Hard Constraints (DCMA metric #5): A good schedule should be driven by logic and not by constraint 

dates, which should be used sparingly. This test counts the number of tasks that have constraint dates 

(including deadlines).  
 

Inactive tasks:  Project 2010 introduced a facility whereby you may mark a task inactive. While there 

may be valid reasons for using this facility, for example when using branching in Full Monte, it is useful 

to know whether a task is active or not. (This test is does not appear in Project 2007.)  
 

Invalid actual date(s)  (DCMA metric # 9 part 2): This test counts tasks with dates for events that have 
already occurred —they are “actual” dates — but are after the status date. This should not occur if the 
project has been properly progressed and scheduled.  
 

Invalid forecast date(s)  (DCMA metric # 9 part 1):  This test counts tasks with dates for events that 
have not occurred — “planned dates” — but are prior to the status date. This should not occur if the 
project has been properly progressed and scheduled.  
 

*Lags bigger than threshold (DCMA metric #3):  This counts the number of relationship lags that exceed 

a user-specified duration.  

 

Note: Any task exclusions apply to the successor task only. 

 

*Leads bigger than threshold (DCMA metric #2):  A lead is a negative relationship lag. This test counts 

the number of relationship lags that exceed a user-specified duration.  

 

Note: Any task exclusions apply to the successor task only. 
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LOE tasks on critical path: This relates to Level of Effort (LOE) tasks, which represent supervisory 

activities whose duration should be determined by the dates of other tasks.  These tasks should not be 

on the critical path.   

 

Note:  This test is disabled if the field used to indicate LOE tasks is not defined on the 

configuration dialog.  

 

LOE, Summary, and Milestone not mutually exclusive: The DCMA guide implicitly assumes these 

designations are mutually exclusive, but this is not enforced automatically because they are designated 

using different fields. This test is to confirm that they are in fact mutually exclusive. 

 

Manually scheduled tasks:  Project 2010 allows tasks to be flagged as manually scheduled, which 

defeats the purpose of CPM scheduling. This is not permitted by DCMA and not supported by Full Monte.    

 

Note: The test does not appear in Project 2007.   

 
Milestones with resources:  Milestones do not represent actual work and should not be resource-
loaded.  This test counts any milestones which have resource assignments. 
 

Note: the definition of milestone is not necessarily the Project milestone flag, but as defined on 
the configuration screen. 

 

Missed tasks (lateness exceeds threshold) (DCMA metric # 11): This test compares the task’s actual or 
planned dates with the task baseline dates.  
 

Note: This test is disabled if there is no baseline.   

 

More than threshold number of predecessors: This test counts the number of tasks that have more 

than a specified number of predecessors. This number can be set by the user, the default being 10. 

 

More than threshold number of successors: This test counts the number of tasks that have more than a 

specified number of successors. This number can be set by the user, the default being 10. 

 

Negative slack exceeds threshold (DCMA metric #7):  This test counts the number of tasks with more 

than a user-specified amount of negative total slack. Negative slack implies that the project completion 

date (or some intermediate milestone date) cannot be achieved. Ideally there should be no tasks with 

negative slack. 

 

No baseline start or finish date:  The default setting for the DCMA tests requires every task to have a 
valid baseline start and finish date, and excludes those without baseline dates from the calculation of 
most metrics.   This test counts those which do not have one or both of the baseline dates. 
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No predecessors (DCMA metric #1): This counts the number of tasks that have no predecessors. This is 

allowed —there must of course always be one such start task — but an excessive number of such tasks 

would suggest that the schedule is driven by constraint dates rather than logic.  

 

Note: DCMA metric #1 combines the tests on predecessors and successors, reporting the number 

of tasks which are missing one or the other without double counting those where both are 

missing.  This statistic is shown on the DCMA view.  Note also that while there must be at least 

one start task and at least one finish task, and while multiple starts or finishes may also be 

acceptable, any task which has neither is almost certainly in error.  Finally note that this test 

checks explicit relationships only and not those implied by parent-child relationships.  

 

No resources (DCMA metric #10): All regular tasks represent work and should therefore have resource 

assignments. This test counts tasks that do not have resource assignments.   

 

Note: This test would normally exclude Summary, Milestone, and Level of Effort tasks. 

 

No successors (DCMA metric #1):  This counts the number of tasks that have no successors. This is 

allowed — there must of course be one finish task — but an excessive number of such tasks would 

suggest that the schedule is driven by constraint dates rather than logic. 

 

Note: DCMA metric #1 combines the tests on predecessors and successors, reporting the number 

of tasks which are missing one or the other without double counting those where both are 

missing.  This statistic is shown on the DCMA view.  Note also that while there must be at least 

one start task and at least one finish task, and while multiple starts or finishes may also be 

acceptable, any task which has neither is almost certainly in error.  Finally note that this test 

checks explicit relationships only and not those implied by parent-child relationships.  

 

Out of sequence progress: This test checks for situations where a task is marked as having started 

before one or more of its start predecessor events is complete, or when it is marked as complete before 

one or more of its finish predecessor events is complete. 

 

Planning packages before cutoff date: This test relates to rolling wave scheduling, where work beyond a 

certain point in the future is not planned in detail but represented by “planning packages.”     The test 

checks for any planning packages which are not sufficiently far in the future, based upon a calculated or 

user-specified cut-off date.  (The method of calculating this date is defined on the configuration dialog.)  

 

Note: This test will be disabled if the field used to indicate planning packages is not defined on 

the configuration dialog. 

 

Slack exceeds threshold (DCMA metric #6):  This test counts the number of tasks with more than a user-

specified amount of total slack. 
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Summary tasks with relationships: This test counts the number of summary tasks with relationships. 

While there is nothing intrinsically wrong with summary tasks having relationships, this capability should 

be used sparingly because it can cause confusion. The DCMA guide does not allow relationships on 

summary tasks at all. 

 

Summary tasks with resources:  This test counts the number of summary tasks with resource 

assignments. As summary tasks do not directly represent work, they should not have resources assigned 

to them. (Full Monte ignores any such resource assignments and the DCMA guide does not allow them.) 

 

 Tasks with redundant predecessors:  This test relates to relationships that have no effect because they 
are implied by other logic. For example, if C depends on B and B depends on A, then it is generally not 
necessary to say that C depends on A.  Schedule Inspector counts the number of tasks that have 
redundant predecessors.   There are more complicated examples involving summary tasks.  A 
relationship is considered redundant if it cannot affect the results of the analysis even if task durations 
change due to direct user input, progressing, or between trials in a Monte Carlo simulation in Full Monte. 
 

Note however that any relationship can be rendered non-redundant if it is given a small enough 

(maybe negative) lag, so if you use lags take care before removing relationships identified as 

potentially redundant. 
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CHAPTER 6: The DCMA View 

 

The DCMA view is a view which presents the metrics in the DCMA 14-point schedule assessment guide 

in a familiar format, shown in figure 6.1. 

 

The view is accessed by clicking on the “DCMA View” menu item at the top of the screen.  This item will 

be enabled only if certain conditions obtain: 

 

1. All of the DCMA tests must be selected. 

2. The exclusions must match the DCMA defaults. 

3. The results must be current.    

 

Note:  it is not required that the thresholds or goals match the DCMA defaults since both of these 

values are displayed on the report. 

 

The easiest way to achieve this is as follows: 

 

1. On the configuration dialog (Options/Configure), make sure that: 

 

 There is a baseline defined. 

 The “baseline required’ checkbox is checked. 

 Fields are specified for the identification of planning package and level of effort tasks.  

 

2. Click on Options/Reset for DCMA 

 

3. Click on Run Tests/Run Now (not necessary if Run Automatically is checked). 
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Figure 6.1 

 

 

The File menu at the top left of the DCMA view offers options to print the view or to copy it to the 

clipboard for insertion in other documents. 
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CHAPTER 7:  Printing, Clipboard, and Export to CSV 

 

On the main screen, the File menu offers options to: 

 

 Print the table (in a choice of two formats). 

 Save the table to a CSV file which can be read by Excel. 

 Copy the table to the clipboard so that it can be pasted in Word or other documents. 

 

NOTE: These options are disabled unless there is at least one test selected and the results of all 

selected tests are up-to-date. 

 

Clicking on Print gives you two options: 

 

 Report produces a special black-and-white format designed for printing. 

 Screen Display produces a color report similar to the screen display, but not limited in size (so all 

unhidden rows will appear, and there will not be scroll bars.) 

 

In either case it invokes the print preview function, shown in figure 7.1 for the Report case.   In the print 

preview screen, you may change some of the settings before printing. While the printed report differs in 

format from the screen display, it respects the sort order and the Hide Unselected Rows setting.  

 

 
Figure 7.1 

 

The Save to CSV and Copy to Clipboard options are self-explanatory. 
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CHAPTER 8:  Defaults 

 

By default, all the options are initialized to the values last used. It is also possible to reset the values to 

either: 

 

• The DCMA defaults, by selecting Reset for DCMA from the Options menu, or 
 

• More general defaults, by selecting Reset to System Default from the Options menu. 

 

Some tests require a baseline, while others require that fields be specified to identify Level of Effort (LOE) 
or Planning Package (PP) tasks.  If the data is not available for certain tests they will not be enabled, and 
the following message appears: 

 

 
Figure 8.1 

 

Note:  The DCMA default includes the setting to require baselines, i.e. to consider only tasks with 
baseline dates.  However if no baseline is selected this option will not be set.   
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Appendix A: List of Tests 

Test Standard DCMA Allowed  Individual Global  

 
Default Default Exclusions Fix Fix 

      Baseline duration exceeds threshold x x  CLMNPS* No No 

Baseline execution index   x  LMNPS No No 

Critical path length index   x  CSLP No No 

Critical path test   x  CLMNPS* No No 

Duplicate task names x 
 

  Rename Various options 

Finish-Start relationships x x  CLMNPS Edit/delete No 

Hard constraints x x  CLMNPS Edit/delete 
Remove 
constraints 

Inactive tasks # x 
 

 CLMNPS Set to active Set to active 

Invalid actual date(s) x x  LMNPS* 
Set dates to 
planned 

Set dates to 
planned 

Invalid forecast date(s) x x  LMNPS No No 

Lags bigger than threshold x x  CLMPS Edit/delete No 

Leads bigger than threshold x x  CLMPS Edit/delete No 

LOE tasks on critical path   x  C Change flag No 

LOE/Summary/Milestone not mutually exclusive   x  C Change flag No 

Manually scheduled tasks # x 
 

 CLMNPS Set to automatic Set to automatic 

Milestones with resources x 
 

 C 
Remove milestone 
flag** 

Remove milestone 
flag** 

Missed tasks (lateness exceeds threshold) x x  CLMNPS No No 

More than threshold number of predecessors x x  CLMNPS Delete No 

More than threshold number of successors x x  CLMNPS Delete No 

Negative slack exceeds threshold x x  CLMNPS No No 

No baseline start or finish date x x  CLMNPS 
Set baseline to 
current dates 

Set baseline to 
current dates 

No predecessors x x  CLMPS Add No 

No resources x x  CLMNPS Add No 

No successors x x  CLMPS Add No 

Out of sequence progress x x  CLMNPS* No No 

Planning packages before cutoff date 
 

x  C No No 

Slack exceeds threshold 
 

x  CLMNPS No No 

Summary tasks with relationships x x  C 
Move to 
milestones No 

Summary tasks with resources x 
 

 C Move to child task No 

Tasks with redundant predecessors x    CLMNPS* Delete No 

      
        

# These tests do not apply to Project 2007. 

* Summary MUST be excluded for these four tests. 
** Only if milestone designation uses the flag.
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